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This chapter discusses the 

latest version of Microsoft 

Office, with its ribbon-style 

user interface. It identifies 

the range of editions, and 

outlines the requirements 

for installation. Also covered 

are: the process of starting 

applications; features used 

by all Office applications 

such as Preview and Save;  

Office document types; and 

compatibility with the older 

versions of applications.  
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Microsoft Office
Microsoft Office is a suite of productivity applications that 
share common features and approaches. There are two versions: 
Microsoft Office for one-time purchase, and Microsoft 365 on a 
regularly updated subscription basis. 

There are various retail editions of Microsoft Office:

Office Home & Student edition contains:  

• Excel    Spreadsheet and data manager 

• PowerPoint   Presentations and slide shows 

• Word    Text editor and word processor

Office Home & Business edition contains all of the apps in the 
Home & Student edition, plus:  

• Outlook   Electronic mail and calendar

Office Professional edition contains all applications found in the 
Home & Business edition, plus two additional apps:  

• Access   Database manager 

• Publisher   Professional document creation

Similarly, Microsoft 365 has various subscription editions:

Microsoft 365 Personal edition contains all the apps (Excel, 
PowerPoint, Word, Outlook, Access and Publisher) for one 
individual – licensed for 1 PC, 1 tablet, and 1 phone.

Microsoft 365 Home edition also contains all the apps, but for an 
entire household – licensed for 5 PCs, 5 tablets, and 5 phones.

Microsoft 365 Business edition has all apps except Access, plus: 

• OneDrive for Business Online file storage and sharing

Microsoft 365 Business Premium edition contains all the apps 
found in Microsoft 365 Business (including OneDrive), plus these: 

• Microsoft Exchange Hosted messaging solution 

• SharePoint Online  Collaboration web services 

• Skype for Business  Hosted communications service

Microsoft 365 Enterprise editions contain all applications found 
in Microsoft 365 Business Premium edition but also provide 
additional security and information management tools.

Office Online (see pages 
228-229) provides free 
web-based versions 
of the common apps, 
and Office Education 
provides special features 
designed for schools, 
teachers, and students.

OneNote for 
Windows 10 is now the 
default, and an Office 
version of OneNote is no 
longer included in Office 
or Microsoft 365. You 
can still use the previous  
OneNote 2016 if you 
desire. 

Microsoft Office suite 
is available for a one-
time payment and based 
on the same applications 
as the subscription 
version – Microsoft 365 
(formally named Office 
365). 
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The Ribbon interface also provides 
extended ScreenTips that can 
contain text, images, and links to 
more help. The tips display as you 
move the mouse pointer over an 
option, and describe the functions 
or give keyboard shortcuts. For 
example, move the pointer over the 
Chart command on the Insert tab. 

Whichever edition of Office or Microsoft 365 that you have, 
the applications they provide will all feature the graphical user 
interface based on the Ribbon. This replaced the menus and 
toolbars that were the essence of earlier versions of Office.

The Ribbon contains command buttons and icons, organized in 
a set of tabs, each containing groups of commands associated 
with specific functions. The purpose is to make the relevant 
features more intuitive, and more readily available. This allows 
you to concentrate on the tasks you want to perform, rather than 
the details of how you will carry out the activities. Some tabs 
appear only when certain objects are selected. These are known 
as contextual tabs, and provide functions that are specific to the 
selected object. For example, when you select an inserted image, the 
Picture Tools, Format tab and its command groups are displayed.

Ribbon Technology

This result-oriented 
user interface was first 
introduced in Office 
2007, and now appears 
in all the applications in 
Office.

For systems with touch-
enabled monitors, Office 
offers a Touch Mode 
ribbon with larger and 
more widely spaced 
icons (see page 14).
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What’s Needed
To use Microsoft Office or Microsoft 365, you will need at least 
the following components in your computer:

• 1GHz processor (32-bit or 64-bit).

• 2GB RAM memory.

• 3GB available disk space.

• 1280 × 800 or larger  
resolution monitor.

• DirectX 10 graphics card.

• Any edition of Windows 
10 or Windows Server 10. 

Some functions will have additional requirements; for example:

• Touch-enabled monitor for controlling the system.

• Internet connection for online help.

• CD-ROM or DVD drive for installation, backup and data 
storage purposes.

Since your computer is required to run a version of Windows 10, 
the system specifications should meet and exceed the requirements 
for Microsoft Office or Microsoft 365.

These system properties 
are for the PC used 
in this book, which is 
running Windows 10 
Pro. However, the tasks 
and topics covered will 
generally apply to any 
supported operating 
system environment.

These are the minimum 
requirements. A higher-
speed processor with 
additional memory will 
produce faster results.
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Installing Microsoft Office
You can buy your preferred version of Microsoft Office in disk 
format from a retail source, or download it directly from an online 
supplier or from Microsoft itself. However, Windows 10 provides 
the Office app on the Start menu. This checks the current status 
of Office on your system. If Office is not already installed, you’ll 
be offered the opportunity to take on a one-month trial of 
Microsoft 365. This is the subscription-based version of Microsoft 
Office. When this trial ends, you can commit to a subscription 
for Microsoft 365 to work across multiple devices or choose the 
Microsoft 365 Personal version, which lets you use Office on one 
PC, one tablet, and one phone. This also gives you a massive 1TB 
of storage for one user.

l1 Click the Office Start menu tile or All Apps 
entry to check your Office status

l2 If Office is not installed, choose Install Office and follow 
the prompts to begin the installation

To compare the editions 
of Office and Microsoft 
365, visit products.
office.com/en-us/buy/
compare-microsoft-
office-products, where 
you can also try or buy 
the products.

l3 When the install 
completes, you can 
explore the Office 
applications added

Microsoft is eager to 
encourage adoption of 
the subscription versions 
– Microsoft 365 Personal 
edition also includes 60 
minutes per month of 
Skype calls to cell phones 
and landlines.
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Start an Application
With Microsoft Office installed under Windows 10, you can use 
the Windows 10 Start menu to launch an Office application. For 
example, to start PowerPoint: 

l1 Select the Start button to display 
the All Apps list 

l2 Scroll the alphabetic listing to the 
P heading

l3 Choose the PowerPoint entry to 
launch the PowerPoint application

To locate the application more quickly, use 
the Search box on the Taskbar:  

l1 Click in the Search box on 
the Taskbar 

l2 Begin typing the application 
name; e.g. powerpoint 

l3 Click the PowerPoint desktop 
app entry to launch the 
PowerPoint application

For even quicker access to the Office applications, add tiles to the 
Start menu: 

l1 Locate an Office application 
such as PowerPoint using the 
All Apps list as described above 

l2 Right-click the application entry and select Pin to Start, 
typing the application name; e.g. powerpoint 

l3 Repeat this procedure for each Office application 

In Tablet or Full Screen 
mode, select Start then 
click the All Apps button 
to show the All Apps list. 

You can also right-click 
the desktop app in your 
Search results to choose 
to Pin to Start (or to 
choose Pin to taskbar). 
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…cont’d

l4 Click Start to display the Start menu, resize and arrange 
the Office application tiles, and provide a group name

You can resize desktop 
app tiles as Medium or 
Small, but the Wide and 
Large options are not 
available. 

If you have a 
microphone and Voice 
Recognition enabled on 
your system, you can  
command Cortana to 
launch an application, 
by saying, for example, 
“Hey Cortana. Start 
PowerPoint”. 

l5 Now, to launch an Office application, select Start and 
click the appropriate tile

You can place icons on the Taskbar for the applications you use 
most frequently.  

l1 Right-click the application entry on the All Apps list, and 
select More, then Pin to taskbar 

l2 Repeat this procedure for any other frequently used 
Office application 

l3 Your frequently used applications will now be available by 
simply clicking an icon on the Taskbar
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l3 Click the Touch/Mouse Mode 
button on the Quick Access Toolbar, 
and then select Touch

l4 The expanded Ribbon is displayed, 
with extra space between the icons 
and commands, making them easier to select by touch

Application Start

l1 Select an Office application item such as Word, using any 
of the methods described on pages 12-13, to display that 
application’s Start screen

The Touch/Mouse 
Mode button appears 
by default when you 
have a touch-enabled 
monitor. To add it if 
not displayed, click 
the Customize Quick 
Access Toolbar button 
and then select Touch/
Mouse Mode. You can 
then display the enlarged 
Ribbon on a standard 
monitor.

Document-based Office 
applications open at the 
Start screen with the 
Recent list and various 
document templates.

l2 Select Blank document to begin a new editing session 
with an empty document
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The Application Window
When you start an Office application such as Excel, PowerPoint 
or Word, the program window is displayed with a blank document 
named “Book1”, “Presentation1”, or “Document1” respectively. 
Using Word as an example, parts of the application window include:

Backstage    Quick Access Toolbar   Document name   Tabs 
(File tab) 

Status bar   Horizontal scroll bar   View buttons   Zoom level 
      may appear here

When you have updated your document and want to save your 
progress so far, click File to display the Backstage command 
screen and then select Save to name and save the document. You 
can save it in your OneDrive (see page 16) or on your computer. 

“Tell Me” Help box 
Ribbon Display options

Minimize/Restore/Close

Ribbon Command icons 
(display lists or galleries)

Collapse the Ribbon

Group launch button 
(shows dialog box)

Vertical scroll area

From Backstage you can 
select Info for details 
about your document, 
or New to start another 
document, or Open 
to display an existing 
document. There are 
also printing and sharing 
options provided.

File commands   Browse the         Save locations      Recent folders 
   selected location 

The Tell Me Help box 
is available in Word, 
Excel, Outlook, and 
PowerPoint.
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Your OneDrive
To save documents to your OneDrive online storage:

l1 Select File, Save As, then click 
the OneDrive button

l2 Confirm or amend the document name, then choose the 
appropriate folder (e.g. Office2019) and click Open 

l3 Click Save to upload the document and save it to your 
OneDrive folder

l4 To access your OneDrive from a browser, go online to 
onedrive.live.com, and sign in if prompted

OneDrive lets you access 
and edit your documents 
from any computer 
where you sign in with 
the same Microsoft 
Account. You can also 
access your OneDrive 
and documents from a 
web browser.

OneDrive was previously 
known as SkyDrive. 
When you set up a 
Microsoft Account to 
sign in to Windows, 
you are assigned an 
allowance of up to 
5GB online storage, 
which is managed on 
the Microsoft OneDrive 
server (see also page 
228). A Microsoft 365 
subscription gives you a 
further 1TB of storage 
(correct at the time of 
printing).
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…cont’d

If you have a new system, or have just updated to Windows 10, 
you may be required to configure OneDrive. 

l1 Select OneDrive and if asked to set up OneDrive, enter 
your Microsoft Account email and click Sign in 

By default, the local 
copies of your OneDrive 
files will be stored in 
your personal folder on 
your hard drive, though 
you can change the 
location during setup. 

l2 Enter your Microsoft 
Account password, and 
follow the prompts to 
complete the setup 

l3 Click Open my 
OneDrive folder to see 
the initial features

To start with, you’ll have a Documents folder and a Pictures folder, 
plus an advisory document. You can create more folders, and these 
will be synced with your online OneDrive and accessible from any 
device where you sign in with your Microsoft Account. 

The files on your 
OneDrive can be online,  
and downloaded when 
needed and flagged as 
Available. You can mark 
important files as Always 
keep on this device. 
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With the Ribbon interface, you can immediately see the full effect 
of format options, such as fonts and styles, on your document by 
simply pointing to the proposed change. For example, to see font 
formatting changes:

l1 Highlight the text that you may wish to change, then 
select the Home tab

Live Preview

l2 Click the arrow next to the Font box and move the 
mouse pointer over the fonts you’d like to preview

l3 Click the font you want to apply to the 
text, or press Esc to close the options

l4 Similarly, you can preview Text Effects, 
Highlight Colors and Font Colors

In earlier versions, you 
would be shown a 
preview of the new font 
or style using a small 
amount of sample text. 
Office now displays full 
previews.

The selected text is 
temporarily altered 
to show the font (or 
the font size, color or 
highlight) you point to.
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The Ribbon takes up a significant amount of the window space, 
especially when you have a lower-resolution display. To hide it:  

l1 Click the Collapse the Ribbon 
button (see page 15), or   
 
Right-click the Tab bar and 
select Collapse the Ribbon

Working with the Ribbon

Hold down the Alt key 
and press the keys in 
sequence for a two-
letter shortcut, such as 
Alt + FS (Font Size), and 
press Esc to go back up 
a level.

l5 Press Alt + shortcut key (for example, Alt + H to select 
Home) and display the Ribbon and shortcuts for that tab

l2 The Quick Access Toolbar and the Tab bar will still be 
displayed while the Ribbon is minimized

l3 The Ribbon reappears temporarily when you click one of 
the tabs, so you can select the required command

l4 Alternatively, press and release the Alt key to display 
keyboard shortcuts for the tabs

You can also select 
Ribbon Display 
Options on the 
Windows title bar and 
choose Show Tabs 
to hide the Ribbon, 
or Show Tabs and 
Commands to reveal 
the Ribbon.
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Quick Access Toolbar
The Quick Access Toolbar contains a set of commands that are 
independent of the selected tab. There are five buttons initially:

    Save   Undo   Repeat/Redo     Touch/Mouse   Customize Quick  
                      last command        Mode         Access Toolbar

l1 Click the Save button to save the current contents of the 
document to your OneDrive, or to the drive on your PC

l2 Click Repeat to carry out the last action again, or click 
Undo to reverse the last action, and click again to reverse 
the previous actions in turn

l3 When you have pressed Undo, the Repeat 
button changes to become the Redo button, 
which will re-apply in turn the actions that 
you have reversed

l4 Click the Customize button to add 
or remove icons, using the shortlist of 
frequently referenced commands

l5 Click More Commands... to display 
the full list of commands, then add and 
remove entries as desired

You can also click the 
File tab, then select the 
application Options and 
select Quick Access 
Toolbar to display this 
dialog box.

You can right-click any 
command on the Ribbon 
and select Add to 
Quick Access Toolbar.

The Save As dialog will 
open the first time you 
press the Save button 
for a new document.
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The files you create using the Office applications will be office 
documents of various types, including:

•Word document  Formatted text and graphics  

•Publisher publication Flyers and brochures   

•Excel worksheet  Spreadsheets and data lists  

•PowerPoint presentation Presentations and slide shows 

Each item will be a separate file. Typically, these may be saved in 
your OneDrive Documents folder (or locally on your computer).

l1 To review your files, open File Explorer and select your 
OneDrive Documents folder

Office Document Types

l2 This shows each file as a large icon plus name and 
OneDrive status. For other styles, click the View tab 
and select, for example, Details, to show additional file 
information such as date modified, type and size 

Right-click the header 
line for Details, and 
you can select other 
file attributes such as 
Date created, Authors, 
Dimensions, etc.

You can specify another 
folder or sub-folder to 
organize particular sets 
of documents.
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File Extensions
To see the file extensions that are associated with the various 
document types:

l1 In File Explorer, select the 
View tab and in the Show/
Hide section of the Ribbon 
click the box labeled File 
name extensions. Select 
Hidden items also, if you want 
to check if there are any hidden files in your folder 

l2 View the contents of your OneDrive Documents folder

l3 The file extension will be shown alongside the file name, 
whichever folder view you choose; e.g. in Details view 

You can also change 
File Explorer Options 
in the Control Panel, 
under Appearance and 
Personalization.

Files saved in Office use 
OpenXML formats and 
extensions; for example, 
.docx and .xlsx. Older 
Office files will have file 
types such as .doc 
and .xls.
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Office will open documents created in previous versions of Office 
applications; for example .doc (Word) or .xls (Excel).

l1 Click the File tab and select Open, then Browse. Choose 
your Documents folder then click the Down arrow to 
display the list of document types supported 

Compatibility Mode

l2 Choose the document type (Word 97-2003 for example) 
then select a specific file (e.g. English Heritage.doc)

l3 Documents created in previous versions (including .docx 
files from Word 2010) are opened in Compatibility Mode Compatibility Mode 

prevents the use of new 
or enhanced features, 
so the documents can 
be used by systems with 
older versions of the  
applications.

You may need to 
save documents in 
Compatibility Mode, as 
some users you wish to 
share files with may not 
have the latest version of 
Office.
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If you have opened a document in Compatibility Mode, you can 
convert it to the latest Office format.

l1 Select the File tab and Info, 
then the Convert button 

l2 Click OK to confirm, and the 
file type will be amended

Convert to the Latest Office Format

With Save As, you have 
the option to change 
the file name, and the 
location for the new 
document.

Converting will create a 
file of the same name, 
but with the latest 
Office format extension. 
The original file will be 
deleted.

You can also click the 
File tab, select Save As, 
and choose the standard 
Office format (e.g. Word 
Document) to carry out 
the conversion.

l4 To retain the original while creating a new file in the latest 
Office format, you’d select File, Save As, and then click 
the Save button 

l3 To replace the original file, 
select File and then Save – 
see the file extension change 
in the Word title bar to the 
new .docx file type
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